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Solid Problem Two 
 

 
This chapter will cover the following to World Class standards: 

 
 Sketch of Solid Problem Two 
 Starting a 3D Part Drawing 
 Drawing a Closed Polyline Shape to be Extruded 
 Extruding a Solid from a Closed Polyline  
 Rotating a 3D Solid Using the Rotate3D and Rotate Commands 
 Drawing a Solid Box 
 Rotating and Moving a Solid onto the Master Solid 
 Mirroring a 3D Solid  
 Subtracting a Solid from another Solid 
 Improve the View by Hiding Tessellation Lines 
 Moving the Solid to the Origin Point 
 Saving the Solid Problem 
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Sketch of Solid Problem Two 
________________________________________________________ 
 
You will start the second solids problem with a rough sketch showing the dimensions of each 
detail. This part is symmetrical across two lines which you can call the x-axis and the y-axis, 
leaving the z-axis as the vertical rise of the piece. In this exercise, a strategy you will learn is to 
draw a closed Polyline that contains the most complex shape of the component and then use 
simple geometric solids to add or subtract detail.  In problem two, the upside-down “T” contains 
the intricate contour that will be formed into the Polyline shape, and the 63 degree wedge in the 
middle of the part will be the smaller aspect that will be addressed secondly. 
 

 
 
Figure 3.1 – Problem Two sketch 
 
When you receive a sketch from a professional, you need to practice quickly identifying the 
complex shapes and deciding how to proceed with the solid exercise. These ten drills in the 
Fundamentals of 3D Drawing textbook will give you those repetitive maneuvers which will 
make you a successful in the 3D modeling. 
 

Starting a 3D Part Drawing 
________________________________________________________ 
 
In Problem Two, you will begin the 3D drawing by selecting the Mechanical template. In 
Figure 3.2, the window “Select template” is loaded by selecting the New tool on the Quick 
Access toolbar. A list of templates is loaded; scroll down the list and select 
Mechanical.dwt. A new drawing file will open that contains the system variables and layer 
definitions, which you will use later in Paper Space to finish the drawing. 
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Figure 3.2 – Starting the drawing using the mechanical template 
 
 
 

Drawing a Closed Polyline Shape to be Extruded 
________________________________________________________ 
 
Drawing a closed Polyline is not new to you because you will draw the contour of this 
solid similarly to the outside wall drawn in the Fundamentals of 2D Drawing Architectural 
Floor Plan. A Polyline is not like a typical set of lines since the entity can contain multiple 
start and ending points identifying each line segment in the shape. Polylines can also 
contain arcs that form intricate smooth curves that will be useful in developing castings in 
advanced parts drawn in your future. 

 

On the Draw panel under the Home tab, select the Polyline tool and specify a start point in the 
lower left hand corner of the graphical display. In Figure 3.3, you can see the actual continuous 
line of data you need to specify at the command line. 

 

Command: _pline 
Specify start point: 
Current line-width is 0.0000 
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 4.5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 0.75 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 0.75 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 2.75 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 3 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 2.75 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 0.75 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: C 
 

With the Ortho mode “on,” draw a 4.5 unit line to the right, a 0.75 line up, a 0.75 line to the left, 
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a 2.75 line upward, a 3.0 line to the left, a 2.75 line downward, a 0.75 to the left and then type 
“C” to close the Polyline. A closed entity will appear in the graphical display. Select the Zoom 
Extents tool on the Standard toolbar to have the box fill the monitor, so you can proceed to the 
next step in the drawing process. 
 

 
 

  
Figure 3.4 – Drawing a closed polyline Figure 3.5 – Isometric view of the shape 

 
On the View panel, select the Southwest Isometric view from the drop menu to allow you to see 
the part on the XY plane and the vertical Z-axis will rise from the level surface (Figure 3.5).  
 
 
 

Extruding a Solid from a Closed Polyline 
________________________________________________________ 
 
Only closed entities like Polylines and Circles can be extruded into solids using this very 
powerful tool on the 3D Modeling panel. If a there is even a minute space in the entity, the 
program will consider it a line and then extrude the outline to a surface rather than a solid.  
If you use an attention to detail in your 3D computer aided design work, you can create the 
most complex shapes with the extrusion instrument.  
 
Select the Extrude tool on the 3D Modeling panel and the command line will prompt you to 
“select objects.” Pick the Closed Polyline anywhere on the peripheral line and the command line 
will return with “1 found” as shown in Figure 3.6. Hit ENTER to specify the height or path of 
the solid. You can type “P” for Path and choose an entity to extrude the shape along, but you 
will not want that option for problem two. You will type “3” for the height of the extrusion and 
for the angle of taper you will hit ENTER to accept the zero degree default. A more complex 3D 
solid will appear in the graphical display as shown in Figure 3.7. 
 
Command: _extrude 
Current wire frame density:  ISOLINES=4 
Select objects: 1 found 
Select objects: 
Specify height of extrusion or [Path]: 3 
Specify angle of taper for extrusion <0>: 
 

Figure 3.6 – The extrude command 
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Figure 3.7 – Extruding the polyline shape 
 
 
 
 

Rotating a 3D Solid Using the Rotate3D and Rotate Commands 
________________________________________________________ 
 
There are four modifying commands that are useful in handling 3D components:  3DArray, 
Mirror3D, Rotate3D and Align.  The 3D array function opens the third tier of creating an array 
using rows and columns, but adding the third layer to copy new entities into the z direction. The 
3D mirror tool will allow any entity capable of 3D movement to cross any plane defined by 
three points. The 3D rotation device will move any solid or even two dimensional units around 
any axis defined by two points in Model Space. The most powerful tool that you can use is the 
Align utility. This last function will move and rotate any object from the original position to the 
destination by drawing three paths from the starting point to their ending point. You will learn 
the Align command in a later exercise.  
 
You can find the 3D Move, 3D Rotate, and 3D Align icons on the Modify panel. 
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Figure 3.9 – Picking the Rotate3D axis Figure 3.10 – The part rotated on an axis 
  
Select the 3D Rotate command from the Modify panel under the Home tab. At the command, 
“select objects,” pick the solid on the graphical display and hit ENTER to continue. Select the 
midpoint of the top right edge of the solid as the rotation point.  You are going to rotate the solid 
part on the x-axis, so pick the diameter of the sphere that surrounds the x-axis, as shown in 
Figure 3.9.  With the Ortho mode still “on” pick a second point drawing a line on the x-axis. 
Type 90 to rotate the solid as shown in Figure 3.10. 
 

 

To rotate the solid in the XY plane, select 
the regular Rotate command from the on the 
Modify panel.  The selected entity will be 
dotted and to continue with the command, 
hit ENTER to select the base point of 
rotation.  Select any point at the base of the 
solid with the left mouse button and then 
type 90 for the degrees of counter clockwise 
rotation to finish this detail (Figure 3.11).   

  
Figure 3.11 – Rotated on the second axis  

  
  
  

Drawing a Solid Box 
________________________________________________________ 
 
The technique you will use in this exercise will utilize the Length option of the Box 
command. Type L after specifying the corner on the graphical display and the system will 
ask three questions. The first prompt is “Specify Length,” so when you type a number and 
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hit ENTER the entry will become the X coordinate. The second prompt is “Specify 
Width,” so type a number and hit ENTER to designate the Y coordinate. The third prompt 
is “Specify Height,” so type a number and hit ENTER to designate the Z coordinate.  
 

 

Select the Box tool on the 3D modeling 
panel. At the command line, a prompt asks 
you to specify the corner of the solid and for 
this box; specify any point to the left of the 
solid as shown in Figure 3.11. Type L after 
specifying the starting point and the system 
will ask you three questions. The first 
prompt is “Specify Length” where you will 
type 1 and ENTER for the X coordinate. 
The second prompt is “Specify Width” 
where you will type a 2 for the Y coordinate 
and hit ENTER.  The third prompt is 
“Specify Height” where when you type 2 
and ENTER for the Z coordinate. The 
second box will appear as shown in Figure 
3.12. 

  

Figure 3.12 – Making a solid box  
  
  
  

Rotating and Moving a Solid onto the Master Solid 
________________________________________________________ 
 
Pick Rotate 3D from the Modify panel. At the command, “select objects,” pick the box you 
just drew on the graphical display and hit ENTER to proceed to the second part of the 
function. You are going to rotate the solid part on the x-axis, so pick the diameter of the 
sphere that surrounds the x-axis, and then with the Ortho mode still “on,” pick a second 
point drawing a line on the x-axis. Type 63 to rotate the solid as shown in Figure 3.13. 

 

 

 

 

 

The Move command is actually a three 
dimensional function in the modern 
AutoCAD application software program. 
The way you can determine whether a 
command is three dimensional in nature is to 
attempt to use the function outside the Z-
plane, that is the Z coordinate is not 0. You 
can use move to relocate any entity to 
another point (X,Y,Z) in Model Space. 

  
Figure 3.13 – Rotating the solid box  
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The Move command is separated into two 
parts, the first being the selection process 
and the second being the function of the 
command itself.  To move an AutoCAD 
entity such as a solid box, select the Move 
tool on the Modify panel.  Once you choose 
the Move command, the prompt will be to 
“Select Objects.”  You can do this by 
placing the pick box that now has replaced 
the aperture cursor on the small box and 
select the entity.  The command line will 
respond with “1 found,” so just hit ENTER 
to go the second part of the command.   

  
3.14 – Moving the Box to the Part  

 
Next, you need to “specify base point or displacement” on the graphical display.  Pick the 
midpoint of the lowest edge of the box.   The “second point of displacement” is the midpoint of 
the upper edge of the 2 inch box, as shown in Figure 3.16. Pick the second point using the 
Midpoint Osnap of the larger box, notice that the 2 x 2 x 1 box is now centered on the 2 inch box 
(Figure 3.14). Again, you have accomplished another milestone when moving an AutoCAD 
entity by selecting two known points.  
 

 
 

  
Figure 3.15 – Moving the box down Figure 3.16 – Moving the box down 

 
You can use the Move command to relocate any entity as simply as you did in the Fundamentals 
of 2D Drawing textbook. The Copy command will work similarly, except the original item will 
remain in place and a new solid will appear in the desired location. 
 
Move the box again, this time 1 unit down the z-axis, as shown in Figure 3.15.  Pick any base 
point on the box.  When prompted for Displacement, type 1.  Your finished product should 
match Figure 3.16 
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Mirroring a 3D Solid 
________________________________________________________ 
 

You will use the 3D Mirror tool on the Modify panel to copy the solid object across the 
midpoint of the master solid.  At the prompt to select objects, pick the small box and then 
hit ENTER to proceed to the second half of the Mirror command. “Specify first point of 
mirror plane:” by picking the midpoint of the near left edge of the large box.  “Specify 
second point of mirror plane:” by picking the midpoint of the far right edge of the large 
box.   

 

  

 

Finally, move your cursor straight up and 
select to define the z axis of the mirror plane. 
The default to delete the source objects is no, 
so at the prompt “Delete source objects? 
[Yes/No] <N>:,” just hit ENTER and the 
mirrored and duplicated entities from the top 
half will appear on the bottom half of the top 
orthographic view (Figure 3.17).  Zoom 
extents if necessary to view the entire 
drawing.  You could have also used the 2D 
Mirror tool to copy the box 

  
Figure 3.17 – Mirroring the box  
  
  
  

Subtracting a 3D Solid from Another Solid 
________________________________________________________ 
 
To remove the smaller solid boxes from the master solid, select the Subtract tool on the 
Solids Editing toolbar.    

 

 

The AutoCAD program will prompt you with 
“Select solids and regions to subtract from.” 
Select the larger solid box and the system will 
respond with “1 found.” Hit ENTER to 
proceed to the next step which is “Select solids 
and regions to subtract.” Pick the small 2 x 2 x 
1 box and the software application will counter 
with “1 found.” Hit Enter and a region exactly 
the shape of the small boxes is missing from 
the larger one as shown in Figure 3.19. This 
technique that enhances the detail of a solid 
entity by removing a part of the feature is 
commonplace in the world of 3D design. 

  
Figure 3.18 – Subtracting the two boxes  
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Improve the View by Hiding Tessellation Lines 
________________________________________________________ 
 
In Figure 3.17, you will notice that the tessellation lines representing the solid’s outline 
on the far edge of the part are visible. In a real world solid part, you would not be able to 
see through solid unless the material was transparent. You can use the 3D Hidden Visual 
Style command to remove the hidden lines from your graphical display. 
 

 

Select the Hidden Visual Style from the drop 
menu on the View panel under the Home tab. 
This is a very simple command, because 
moments after picking the tool, the 
tessellation lines representing the back of the 
part are removed from view. Notice in that 
the UCS icon changes from the thin lined 
and arrowed icon to a colorful image. If you 
wish to return the graphical display to the 
previous setup where all the tessellation lines 
are seen, then choose the first tool on the 
Visual Styles toolbar, called 2D Wireframe. 
By choosing the 2D Wireframe tool, the 
solid part and the UCS icon will return to the 
previous appearance. This command does 
not alter the mass of the solid or any of the 
dimensions, but is available for the computer 
aided designer as a viewing option. 

  
Figure 3.18 – Hiding tessellation lines  

  
  
  

Moving the Solid to the Origin Point 
________________________________________________________ 
 
To move Problem Two to the drawing origin of 0,0,0 on the x, y and z axis, select the Origin 
tool on the UCS panel under the View tab.  Select the bottom back left corner of the part to 
move the origin to that corner of the part.  You may find this easier than  
 
* World Class CAD Challenge 03-02 * - Close this drawing file.  Create a New file and 
draw the Polyline and extrude the entity to a solid, draw, rotate and mirror the solid box 
and subtract them.  Move the finished solid to the origin of the drawing.  Complete the 
task in less than 5 minutes.  Continue this drill four times, each time completing the 
drawing under 5 minutes to maintain your World Class ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 
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Figure 3.20 – Moving the finished solid 
 
 

Saving the Solid Problem 
________________________________________________________ 
 
To save Problem 2 in your Fundamentals of 3D Drawing Folder, select the Save tool on 
the Quick Access toolbar. The Save Drawing As window will appear in your graphical 
display. In the Save In list box, select your drawing folder. At the File Name textbox, type 
“Problem 2” and press the Save button to save the drawing (Figure 3.21). 
  

 
 
Figure 3.21 – Saving Problem Two 
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